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Chapter 1

AppsRules Suite Installation Overview

The AppsRules Suite is a set of five integrated applications that work with Oracle

Applications to define business processes, enhance security, and safeguard data

integrity:

* AppsForm modifies the security, navigation, field, and data properties of Oracle
Applications forms.

* AppsFlow works with Oracle Applications Workflows to define and implement
business processes.

* AppsAudit tracks changes to the values of fields in database tables and displays
reports that present information about changes to each field.

»  AppsControl applies change control to Oracle Applications fields — it can moni-
tor change, require a reason for a change, or require approval for a change.

* AppsAccess defines and detects segregation-of-duties conflicts, either preventing
them from occurring or uncovering them so that they can be properly managed.

These applications are installed on the database and forms servers on which Oracle
Applications run. The installation process implements the following architecture:

e Database Schema: Installation requires the identification of a schema for use by
Logical Apps applications. Logical Apps recommends strongly the creation of a
new schema named XXLAAPPS. However, a user who has already established a
schema for third-party products may choose to use that schema instead.
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Chapter 1: AppsRules Suite Installation Overview

Tablespace: Logical Apps recommends creating a tablespace for indexes used by
Logical Apps database objects. (An already established tablespace may be used.)

Database Objects: AppsRules makes use of database tables, packages, sequences,
and workflows, which are placed in the XXLAAPPS (or user-specified) schema. All
Logical Apps table names begin with the prefix L.4.

Application Server Objects: AppsRules uses custom forms, which are installed on
the application server. Custom forms are located in the $XXLAAPPS_TOP/forms/US
directory.

Program Executables: AppsRules uses program executables to report on, migrate,
and compile business rules. The following objects are installed on the concurrent
manager server (typically the database server): reports, programs, and Java files.
Custom programs are located in the $XXLAAPPS_TOP/forms/US directory; some
executable programs may also reside in the $XXLAAPPS_TOP/bin directory.

Logical Apps provides two comprehensive Installer programs that place AppsRules
applications on the database and forms servers. (In addition, they install AppsCore, a
rules engine that provides functionality to the applications.) Each Installer may be
run in any of three modes:

GUI: The Installer programs present a series of windows that prompt you to pro-
vide information necessary for the installation. Each window also provides access
to a help file. As you progress through the windows, you can return to windows
you had completed eatrlier in order to review or change the entries in them. (The
Installers retain any entry you don’t change, even if you return to a step earlier
than the one in which such an entry was made.) GUI mode is the default.

Console: The Installer programs present a series of command prompts in a UNIX
console, in response to which you provide information necessary for the installa-
tion. Console mode prompts for the same information as GUI mode, but does
not enable you to return to earlier prompts and does not provide help screens.

Silent: The Installer programs read parameters from properties files, and then run
without user interaction.

To run each Installer program, you would type its name — ladbinstall.bin or
lafrminstall.bin — at the UNIX command prompt. The name alone launches GUI
mode if no properties files are present, or silent mode if properties files are present;
the name along with the argument —/ console launches the console mode.

Preparatory Procedures

Before installing AppsRules, ensure that the following requirements have been met:

Grant the following APPS schema objects the execute privilege to the XXLAAPPS
schema:

— PND_FILE — Package Spec and Body

— FND_PROFILE — Package Spec and Body
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Confirm that Java is in your path. Type the following at the UNIX command
prompt:

which java

Verity that you use Java version 1.3 or higher. Type the following at the UNIX
command prompt:

java -version

If more than one copy of Java exists on your system, verify the version on the

copy in the opt directory (for example, /ust/optl.3/bin/java).

Ensure that the Oracle Advanced Security product is installed. (Logical Apps uses
DBMS_Obfuscation for encrypting the password.) Type the following at the
UNIX command prompt:

adapters

Look for Oracle Security Server Authentication Adapter among the return values.

Each of your database server, forms server, and concurrent manager server may
run on its own host machine. If so, complete the following tasks to confirm that
the host machines communicate propetly:

— Send a file via FTP from the database server to the concurrent manager
server, and from the concurrent manager server to the forms server.

— Perform a remote execution of the shell file, by any of the following
methods: Enable rsh (remote shell), enable ssh (secured shell), have a
common mount point, manual.

Sizing Considerations

Ensure that your forms server has 100 megabytes (MB) of disk space for AppsRules
files, and that the database server has 100 MB of disk space for AppsRules executable
files.

Moreover, the XXLAAPPS schema requires the following amounts of disk space:

100 MB for most AppsRules database tables.

An additional 1 gigabyte (GB) for two temp tables used in AppsAudit processing
— LAAD_AUDIT_KEYS and LLAAD_AUDIT_VALUES.

An additional amount for two tables that hold “user conflicts” generated by
AppsAccess. The space requirement varies according to the number of conflicts
a system may generate. The first table, LAA_USER_CONFLICT_ENTITIES, holds the
most recent “snapshot,” or set of conflicts; the other, LAA_ USER_CONFLICT_
ENTITIES_H, is a history table that holds archived snapshots. So one would, in
effect, want to allow for double the number of conflicts that may be generated.
The largest Logical Apps clients generate approximately 5,000,000 conflicts and
so need to allow for 10,000,000, and 2 GB of disk space meets this requirement.

Finally the APPS (Oracle Applications) schema requires space to encompass shadow
tables used by AppsAudit — one-third of the space taken by each table that is audited.
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Downloading Installation Files

To begin the installation process, download the file LOGICALAPPS.zip to a temporary
directory on your local system from the FTP site provided by LogicalApps. From it,
extract the two files — ladbinstall.bin and lafrminstall.bin — you will run for database
and forms installation. If you intend to use the silent installation mode, also extract
the two files from which the Installers will read parameters — ladbinstall.properties
and lafrminstall.properties.

Preparing Properties Files

If you intend to run the Installer programs in silent mode, you need first to edit the
two properties files you extracted from LOGICALAPPS.zip, inserting information spe-
cific to your installation. (If you intend to use GUI or console mode, you don’t need
the properties files, and you can ignore this section.)

To insert values in the files, use a text editor such as vi. Each file consists of a series
of name-value statements, each of which sets a parameter name equal to a value and
each of which is preceded by an explanatory comment. (Each comment begins with a
# symbol.) In each statement, edit information to the right of an equals sign; do not
(with one exception, discussed below) modify text to the left of the equals sign.

You insert into the files exactly the same information as you would supply in response
to prompts if you were to run the Installers in GUI mode. For detailed descriptions
of that information, see Chapter 2, “Installing AppsRules Suite.”

The two properties files — ladbinstall.properties (database) and lafrminstall. properties
(forms) — share many parameters, which correspond as follows to the GUI prompts
discussed in Chapter 2:

* CUST_NAME and LICENSE_KEY: Prompts in the License Key window, step 1 on
page 7 (database), or step 1 on page 11 (forms).

*  #HSTAGE_DIR: Prompt in the Staging window, step 2 on page 7 (database), or step
2 on page 12 (forms).

This statement is the exception, noted above, to the rule that you should leave
parameter names (to the left of the equals sign) intact. In the assumption you will
want the Installers to set default staging directories, this statement is commented
out in the properties file. To use the statement, you must not only supply a stag-
ing directory path to the right of the equals sign, but also delete the # symbol at
the beginning of the statement.

* DB_HOST_NAME, DB_SID, and DB_PORT: Prompts in the Database Host window,
step 3 on page 8 (database), or step 3 on page 12 (forms).

*  DB_XXLAAPPS_SCHEMA_NAME, DB_XXLAAPPS_PASS, DB_APPS_SCHEMA_NAME,
and DB_APPS_PASS: Prompts in the Database Schema window, step 4 on page 8
(database), or step 4 on page 12 (forms).

Another exception: The database-installation window does not prompt for the
Oracle Applications schema name, although the forms-installation window does.
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The properties file requires it (typically APPS) as the value for the DB_APPS_
SCHEMA_NAME parameter.

*  XXLAAPPS_SHORT_NAME and APPL_TOP: Prompts in the Application TOP win-
dow, step 5 on page 9 (database), or step 5 on page 12 (forms).

* ENVFILE and ADOVARS: Prompts in the Environment window, step 6 on page 10
(database), or step 6 on page 13 (forms).

The ladbinstall.properties file contains one parameter — INDEX_TABLESPACE — that
does not appear in lafrminstall. properties. This parameter corresponds to the Index
Table Space prompt in step 4 on page 8.

The lafrminstall.properties file contains two parameters that do not appear in the
ladbinstall.properties file. These two parameters correspond as follows to the GUI
prompts discussed in Chapter 2:

e APPSORA: The final prompt in the Environment window, step 6 on page 13.

* CUSTOM_CHOICE: The prompt in the CUSTOM.pll window, step 7 on page 13. In
the properties file, any value other than No (case-sensitive) is equivalent to Yes.

Finally, both files contain a parameter that does not correspond to any GUI prompt.
For you to run the Installers in silent mode, an INSTALLER_UI parameter must be set
to the value sifent. This is the default; don’t change it.
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Chapter 2

Installing AppsRules Suite

In broad terms, the AppsRules Suite installation process involves four steps:

1 Create a tablespace for Logical Apps indexes, and a custom database user/schema.
Logical Apps recommends strongly that the user/schema be named XXLAAPPS.

2 Run the Installer program to place Logical Apps tables, packages, sequences, and
workflows on the database server. All LogicalApps table names begin with the prefix
LA, and all tables reside in the Logical Apps schema (typically XXLAAPPS). The data-
base server installation must precede the forms server installation.

3 Run the Installer program to place LogicalApps forms on the forms server. All
custom forms are located in the $XXLAAPPS_TOP/forms/Us directory.

4 Configure a remote compilation feature, which makes libraries resident on the
concurrent sever available to the forms server.

Creating a User and Tablespace

After extracting installation files from LOGICALAPPS.zip and editing the properties
files if you intend to use silent mode (see “Downloading Installation Files” and “Pre-
paring Properties Files” on page 3), create the LogicalApps tablespace and database
user/schema. The latter must be granted the connect and resource privileges in the
Oracle Applications database. Logical Apps recommends using the name XXLAAPPS
for the new user, and creating all Logical Apps database objects in the XXLAAPPS
schema.
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The following is a sample SQL script that can be used to create the user:

CREATE USER XXLAAPPS

IDENTIFIED BY XXLAAPPS

DEFAULT TABLESPACE &DEF TSPACE
TEMPORARY TABLESPACE &TMP TSPACE
QUOTA UNLIMITED ON &DEF TSPACE
QUOTA OK ON SYSTEM;

GRANT CONNECT TO XXLAAPPS;
GRANT RESOURCE TO XXLAAPPS;

Allocate a minimum of 80 MB of space, 40 on the tmp directory and 40 on the file
system from which the installer is to be launched.

Installing Database Server Components

To install database server components of AppsRules, run the file ladbinstall.bin:

1

Transfer the ladbinstall.bin file to the database server, via FTP in binary mode.
Use the applmgr account.

Use applmgr to log in to the database server. Ensure that the user (login ID) has
write and read privileges on $APPL_TOP.

Execute the environment file, if it is not included in the profile:

$..SAPPL TOP/SAPPLFENV

Set the execute permission on ladbinstall:

$.chmod +x ladbinstall.bin

Execute ladbinstall.bin:

¢ To run in GUI or console mode, ensure that ladbinstall.properties is absent

from the directory where ladbinstall.bin resides. To run in silent mode, be
sure that both files are in the same directory.

e Use the name ladbinstall.bin as the command to run in GUI or silent mode.
Add the argument —7 console to run in console mode.

All three Installer modes require the same information; GUI and console prompt for
it, and silent reads it from files. If you choose GUI mode (as shown in the following
procedure), you can perform these operations in each of the windows:

Review a brief description of the information you need to provide.

Click on the Help button to open a window that provides a more expansive
description of the information you need to provide. (After you review this
information, click on the Close button to exit the Help window.)

Type installation information in the labeled text boxes (or accept default values).

When you complete one window, click on the Next button to move from it to
the next window.

Click the Previous button if you wish to return to a window you completed eatlier.

Note that titles of windows you have completed appear in black along the left of
each window; those yet to be completed are shown in grey.
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To complete the database server installation:

1 Enter your customer name and license key, as Logical Apps provided them to you.
The fields are case-sensitive. When you click Next, a message displays the applica-
tions you are licensed to install; click the OK button to clear the message.

Enter the customer name and license key that you have received
from Logical Ppps.
Both the fields are caze sensitive,

| Cusztomer Mame

Licenze Key

Specify a staging directary, which iz a temporary location for
Logical Apps source files during the installation process.

| Enter Staging Directory ¢
dexport/honesoracl e/rketage/IB_07Nlec200n_134434

The Installer suggests a default directory; its name is a timestamp for the moment
you perform the installation, with DB (for database). If you wish to select another
directory, click the Choose button and, in a Select a Folder window, navigate to
the directory you want. If you specify a nonexistent directory, the Installer creates
that directory. If you navigate away from the default directory and want to return

Installation Guide: AppsRules Suite 7.0 9
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to it, click on the Restore Default Folder button. Make a note of the directory
name; you’ll need it later, when you configure remote compilation.

Verify the default values for the host name, SID (service identifier) and network
port of the Oracle Applications database server, which the Installer takes from
the shell environment. If the defaults are not correct, enter correct values.

Specify the database host name. service SID. and THS port of
the databaze in which Logical Apps applicationz are to be
inztalled,

| Database Host Mame

|mammoth¢whq.logicalapps‘com

SID
|uisdb

Port
|1521

Supply credentials for the Logical Apps schema and APPS

schema,
It iz strongly recommended that you use the name XXLAAPPS for

the Logical Apps schema,

LogicalApps Schema
| [mienpes

Password|

Oracle APPS Schema Password

Index Table Space

As noted earlier, Logical Apps recommends strongly the creation of a dedicated
schema called XXLAAPPS, and the Installer provides this value by default. If you
follow the recommendation, accept the default; otherwise, replace it with the
name of the schema you will use for Logical Apps database objects. Also enter

Installation Guide: AppsRules Suite 7.0
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the passwords for the Logical Apps and Oracle APPS schemas, and the name of
the tablespace for indexes used by LogicalApps database objects.

5 [Establish the Logical Apps TOP — the high-level directory for the storage of
AppsRules files. Specify a directory that is the parent of the Logical Apps TOP
and an application short name that is appended to the parent directory to form
the Logical Apps TOP directory.

~| LogicalApps Database Install | i |

Application TOP

License Key LogicalApps TOP will be created based on the input given
Staging below,

Database Host
Database Schema
m Application TOP

Erwironment

It iz strongly recommended that Logicalfpps be installed asz a
new custom application BALAAPPS

Custom Application Short Name

Input Summary
| LAGPPS |

23 Installing,.s

]:I Ingtall

LogicalApps Application TOP Directory Location
| foracle/bindebizl11h/appl |

REestore Default | | Choosze, , ., |

InstallAnywhere by Zero G

| Cancel | | Help | | Previous | | Mext |

By default, the Installer selects the Oracle Applications TOP as the parent direc-
tory and XXLAAPPS as the application short name. These values are recommended,
but you can change them.

To select another parent directory, click on the Choose button and, in a Select a
Folder window, navigate to the directory you want. If you enter the name of a
nonexistent directory, the Installer creates that directory. To return to the default
directory, click the Restore Default button.

No matter what case you use to enter values, the Installer saves the short name
as all uppercase (and adds the uppercase _TOP to create a top shell variable), and
the directory location as all lowercase. (However, for a reinstallation, the Installer
does not change the case of an existing application TOP.)

If you have selected an application short name that is already in use, the Installer
displays a warning message when you click the Next button:

To respond to this warning:
¢ Click Enter Again to return to the Application TOP form and set a new value.

* Click Continue to accept the duplicate application short name. Doing so, how-
ever, would cause AppsRules and another application to share the name, with
the risk that files for one application or the other might be overwritten.

* Click Abort to abandon the AppsRules installation.
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6 Specify paths to files that contain environment variables for the Oracle Applica-
tions shell. (The installation appends Logical Apps-specific entries to these files.)

Flease enter the envirorment files that set the Oracle
Applications shell environment

LogicalApps environment settings to be weitten to

| Joracles/bindebizl15/appl/visdb_mammoth, env

| Restore Default || Choose, ..

Oracle adovars file

| foracle/bindebizl11b/appl fadmindadovars, enw

| Restore Default || Choose, ..

Accept the defaults, or click a Choose button and, in a Select a Folder window,
navigate to a directory you want. If you enter the name of a nonexistent direc-
tory, the Installer creates that directory. To return to the default directory, click
the Restore Default button.

7 Review your selections in the Input Summary form:

Please review the following carefully before continue

LogicalApps Schama
KALAAPPS

Oracle's APPS Schama
APPS

Tablaspaca to create indexes in
LAAPPS

Database Host Name
marnmath whia logisalapps.cam

Oracle SID
wigdly

Staging Directory
fexporthomeloraclefrkstage/DB_070e: 2005134434

If you determine that any of the entries is inappropriate, you can click on the
Previous button until you reach the form in which you selected the entry, and
change it. (The Installer retains any entries you don’t change, even if you pass by
them as you return to an eatrlier step in the installation process.)

12 Installation Guide: AppsRules Suite 7.0
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8 In the Input Summary form, the label for the button at the lower right has changed
from Next to Install. When you are satisfied with your selections in eatlier forms,
click on the Install button to complete the database server installation.

The Installer displays error messages (if any are warranted) upon completing the instal-
lation of each LogicalApps application, and displays an overall status upon completing
the installation of all products. If the overall status is Success, the installation has fin-
ished with no errors.

If errors occur, they or the overall status may be classified as Warning, Nonfatal, or
Fatal, depending on severity. The Installer recovers (restores the system to its state
prior to the installation) for Fatal errors, but not for Warning or Nonfatal errors. For
details about errors and the installation process, navigate to the directory from which
the Installer ran and review two log files: LADB_LOG_ timestamp.log and LADB_ERROR_
timestamplog, where timestamp is the date and time at which the Installer ran.

Installing Forms Server Components

To install forms server components of AppsRules, run the file lafrminstall.bin:

1 If the database and forms servers run on the same host, re-source the environ-
ment by opening a new shell.

2 Transfer the lafrminstall.bin file to the forms server, via FTP in binary mode.
Use the applmgr account.

3 Use applmgr to log in to the forms server. Ensure that the user (login ID) has
write and read privileges on $APPL_TOP.

4 Execute the environment file, if it is not included in the profile:
S.. $APPL_TOP/$APPLFENV
5 Set the execute permission on lafrminstall:
$.chmod +x lafrminstall.bin
6 Execute lafrminstall.bin:.
* To run in GUI or console mode, ensure that lafrminstall.properties is absent

from the directory where lafrminstall.bin resides. To run in silent mode, be
sure both files are in the same directory.

*  Use the name /lafiminstall.bin as the command to run in GUI or silent mode.
Add the argument —7 console to run in console mode.

Most windows (or console prompts) for the forms installation are identical to those
for the database installation. If you select GUI mode, each window enables you to per-
form the same operations as you could in the database-server Installer (see page 8).

To complete the forms server installation:

1 In the License Key window, once again enter the customer name and license key
provided to you by LogicalApps. These are the same as the values for database-
server installation. Again, when you click the Next button a message displays the
applications you are licensed to install; click the OK button to clear the message.

Installation Guide: AppsRules Suite 7.0 13
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2 In the Staging form, once again select a directory for the temporary placement of

source files. The Installer once again suggests a default — its name this time a time-
stamp for the moment you perform the installation, along with FRM (for forms).

If you wish to select another directory, click on the Choose button. In a Select a
Folder window, navigate to the directory you want. If you specify a nonexistent
directory, the Installer creates that directory. If you navigate away from the default
directory and want to return to it, click on the Restore Default Folder button.

In the Database Host form, select the database host name used where the data-
base installation has been run, and the appropriate SID and port values.

In the Database Schema window, there is no longer an Index Table Space field
(as it would be inapplicable to forms installation), but where the database-server
Installer requested only a password for the Oracle Applications schema, the forms-
server Installer asks for a name as well:

~| LogicalApps Forms Install | i |

Databaze Schema

License Key Supply credentials for the Logical Apps schema and APPS
Staging zchema,
Database Host It iz strongly recommended that you use the name XELARPPS for

the Logical A hema.
m]]atabase Schema i

Application TOP

Erwironment
CUSTOM.p11 LogicalApps Schema
| KHLAGPPS |

d Input Summary

J.:I Installd

Pagzuword | |

Appz Schema
|ePPS |

Pazsword | |

InstallAnywhere by Zero G

| Cancel | | Help | | Prewvious | | Hext |

For the Apps Schema field, accept the default value, APPS. (This needs to match
the database-server value, which is hard-coded.) For each of the remaining fields,
enter the same value as you entered for the database installation.

Once again, Logical Apps recommends the creation of a dedicated schema called
XXLAAPPS. To follow this recommendation, accept the default value; otherwise re-
place it with the name of the schema you will use for Logical Apps database objects.
Also enter the passwords for the LogicalApps and Oracle APPS schemas.

In the Application TOP form, establish the LogicalApps TOP for the forms server
— the highest-level directory for the storage of AppsRules files. Specify a directory
that is to serve as the parent of the LogicalApps TOP, and an application short name
that is appended to the parent directory to form the LogicalApps TOP directory.

The Installer defaults to the forms-server-specific Oracle Applications TOP as
the parent directory and XXLAAPPS as the application short name. These values
are recommended.
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Ensure that the application short name for the forms server is the same as the data-
base server’s. If you wish to select another parent directory, click on the Choose
button and, in a Select a Folder window, navigate to the directory you want. If
you enter the name of a nonexistent directory, the Installer creates that directory.
To return to the default directory, click the Restore Default button.

No matter what case you use to enter values, the Installer saves the short name
as all uppercase (and adds the uppercase _TOP to create a top shell variable), and
the directory location as all lowercase. (However, for a reinstallation, the Installer
does not change the case of an existing application TOP.)

The forms-server Installer, like its database-server counterpart, presents a warn-
ing if you select an application short name that is already in use and it presents
the same response options:

* Click Enter Again to return to the Application TOP form and set a new value.

* Click Continue to accept the duplicate application short name. Doing so, how-
ever, would cause AppsRules and another application to share the name, with
the risk that files for one application or the other might be overwritten.

¢ Click Abort to abandon the AppsRules installation.

6 In the Environment form, specify paths to files that contain environment var-
iables for the Oracle Applications shell (the first two prompts) and for forms
paths (the APPSORA prompt). Accept the defaults, or click a Choose button and,
in a Select a Folder window, navigate to a directory you want. If you enter the
name of a nonexistent directory, the Installer creates that directory. To return to
the default directory, click the Restore Default button. In any case select values
that are appropriate for the forms server.

7 When you complete the Environment form, the forms server Installer presents a
cusTOM.pll form:

~| LogicalApps Forms Install | i |

CUSTOM,pl1

License Key Fleaze choose "Yezs” to overwrite the existing CUSTOM,pll with
Staging CUSTOM,pll provided by Logical Apps.

]]atabase Hast Choosing "Mo” will leave the existing CUSTOM,pll az it isz,
Database Schema
Application TOP
Enwironment

mEUSTDH pll Overwrite CUSTOM,pl1?
T3 Input Summary ® Yes
J:I Installd i Mo
InztallAnywhere by Zera G
Cancel | | Help Prewious | | Hext
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Forms server installation requires that an existing CUSTOM.pll file be modified so
that it can link to an LACUSTOM.pll file. If you select Yes, the Installer backs up
your existing CUSTOM.pll, and then overwrites the original with a modified copy
that contains the necessary links to LACUSTOM.pll. (The backup copy has a time-
stamp appended to the .p// file extension.) If your existing CUSTOM.pll contained
any customization, a Yes selection in this form would require you to copy your
customizations manually from the backup file to the Logical Apps-provided
CUSTOM.plL.

If you select No, the Installer retains your existing CUSTOM.plL. In this case, you
need to edit the file to insert links to LACUSTOM.pI (see below).

8 In the Input Summary form, review the selections you have made. If you deter-
mine that any of the entries is inappropriate, you can click on the Previous but-
ton until you reach the form in which you selected the entry, and change it. (The
Installer retains any entries you don’t change, even if you pass by them as you
return to an earlier step in the installation process.)

9 When you are satisfied with the selections you have made in preceding forms,
click on the Install button in the Input Summary form to complete the forms
server installation.

The Installer displays error messages (if any are warranted) upon completing the instal-
lation of each Logical Apps application, and displays an overall status upon completing
the installation of all products. If the overall status is Success, the installation has fin-
ished with no errors.

If errors occur, they or the overall status may be classified as Warning, Nonfatal, or
Fatal, depending on severity. The Installer recovers (restores the system to its state
prior to the installation) for Fatal errors, but not for Warning or Nonfatal errors. For
details about errors and the installation process, navigate to the directory from which
the Installer ran and review two log files: LAFRM_LOG_ #imzestamp.log and LAFRM_ERROR_
timestamplog, where timestamp is the date and time at which the Installer ran.

CUSTOM.pll Modifications

If you chose (in step 7) not to overwrite your CUSTOM.pll file, edit the CUSTOM.pll
file. (If you selected Yes in step 7, ignore this section and skip ahead to “Configuring
the Remote Compilation.”)

1 In place of the existing code for Procedure Event(event_name varchar2), substitute the
following:

PROCEDURE event (event name varchar2) is

form name varchar2 (30) = name_in('system.current form');
block name varchar2 (30) := name in('system.cursor block');
field name varchar2(30) := name in('system.current item');
function name varchar?2 (30) ;

parameters varchar2 (2000) ;
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begin

if (event name = 'ZOOM') then
la enhncmtmgr pkg.la zooms (form name,block name, function name,
parameters) ;
if function name is not NULL
then
if parameters is null then
fnd function.execute (function name,'Y',6 'N'");
elsif 'ZOOMSPECIAL' = substr (parameters,1l,11) then
lacustom.event ('ZOOMSPECIAL'"); ----- new code 081903
else
parameters := lazoom.zoom event (parameters);
fnd function.execute (function name, 'Y', 'N',parameters);
end 1if;
end if;

elsif (event name='WHEN-NEW-FORM-INSTANCE') then
lacustom.event ('"WNE'") ;

——————————————————————————— WNB
elsif (event_name = 'WHEN-NEW-BLOCK-INSTANCE') then
lacustom.event ('"WNB') ;
—————————————————————————————— WNI
elsif (event name = 'WHEN-NEW-ITEM-INSTANCE') then
lacustom.event ("WNI'") ;
———————————————————————— WNR
elsif (event name = 'WHEN-NEW-RECORD-INSTANCE') then
lacustom.event ('"WNR') ;
———————————————————————— WNV
elsif (event name = 'WHEN-VALIDATE-RECORD') then
lacustom.event ("WVR'") ;
elsif (substr(event name,1,7) = 'SPECIAL') then
execute_menu(event_name);
else lacustom.event (event name) ; --put other events here

end if;
end event;

2 In place of the code for Function go0m_available, substitute the following:

FUNCTION zoom available return boolean is
v_enabled varchar2 (20) ;

begin --x
v_enabled := lazoom.zoom enabled;
IF v_enabled = 'TRUE' THEN
return TRUE;
else
return FALSE;
end if;
RETURN NULL;
end zoom available;

3 Attach the following libraries. (Remove the path when attaching the libraries.)
* LACUSTOM.pll
* LABRSQL.pll

4 Compile the file and ensure there are no compilation errors.

Installation Guide: AppsRules Suite 7.0 17



Chapter 2: Installing AppsRules Suite

Configuring the Remote Compilation

18

To finish the installation, you must configure a remote compilation feature, which
makes libraries resident on the concurrent sever available to the forms server.

1 Log on to the database server.

2 Determine the full path to the Java executable: First, source out the Oracle Appli-
cations shell environment. Then, at the command prompt, type:
which java

3 Navigate to the staging directory (which you selected in step 2 of the database
server installation process).

4 Grant the execute permission on a file called laconfig.sh:

chmod +x AppsCore/db/scripts/laconfig.sh

5 Run the laconfig.sh file:
AppsCore/db/scripts/laconfig.sh argl arg2

e In place of argl, insert the full path of the LogicalApps TOP directory,
followed by “/bin.” Note that the path to the Logical Apps TOP directory
typically contains more than the values you selected in step 5 of the database
server installation process. To determine the path to this directory, use the
echo command, specifying the application short name you selected in step 5
of the database server installation, followed by “_TOP.” For example:

echo S$XXLAAPPS TOP

As an example of a correct value for argl, the path to the Logical Apps TOP
configured on page 11 might be:

/oracle/bin/ebiz115/appl/XXLAAPPS/11.5.0/bin

* In pace of argZ insert the full path of the staging directory (which you
selected in step 2 of the database server installation process), followed by
“/AppsCore.” For example, the cotrect value for the staging directory
configured on page 9 might be:

/export/home/oracle/rkstage/DB_27Jun2005 134434/AppsCore

Running the laconfig.sh file produces a series of command-line prompts. Respond to
them as follows:

1 Enter the full path of the Java executable used by Oracle Applications.

2 You are prompted to enter the LogicalApps short name. The value you enter
must be the same as the short name you created in step 5 on page 11.

3 The following prompt appears:

Choose your Configuration from below:

1. Single-Tier (all tiers on a single node)

2. Multi-node (a separate node for each server)

3. Two Node (one database/concurrent proc. node, one forms/web
node)

4. Two Node (one forms/concurrent proc. node, one database node

5. Exit Program
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Enter 1 if all of the database, forms, and concurrent servers reside on a single
machine; enter 2 if each resides on its own machine; enter 3 if the database and
concurrent servers reside on one machine, and the forms server on another; enter
4 if the forms and concurrent servers reside on one machine, and the database
server on another.

4 The following prompt appears:

Environment File is 'filename'
Does this environment file set Oracle Home (Y/N)

Select Y for yes or N for no as appropriate. If you select N, the system prompts
you for the name of the file that does set the Oracle Home; enter the file name.

5 Ifyou selected option 2, 3, or 4 in step 2, the following prompt appears:

Choose the execution method from below:
1) Secured Shell — ssh

2) Remote execution — rexec

3) Manual

Enter the number corresponding to the protocol you will use for communication
among the machines on which your servers reside.

6 If you selected option 2, 3, or 4 in step 2, the following prompt appears:
Enter the Number of Form Servers:
Enter the number of form servers you have.

7 The following set of prompts appears once for each of the form servers you enu-
merated in step 6 (with the x replaced by a form server number):

Enter the Form Server Number x Host Name:

Enter the Login ID:

Enter the Password:

Enter the full path of LogicalApps binaries on the FORM
Server:

For each set of prompts, enter the host name, the login ID for the owner of
APPL_TOP, that owner’s password, and the appropriate path. You can get the last
of these values by logging on to the form server and typing the following command:

echo @XXLAAPPS TOP bin

Once you have finished executing the laconfig.sh file, verify that the following files
exist and make sure both the Java path and Classpath are set correctly:

* Database server (under $XXLAAPPS_TOP/bin): LAGENLIB.prog, LAMIGRATE.prog,
LAIMPORT.prog

* Forms server: LAFORMSGEN.prog

Finally, if you want to enable migration (the ability to port AppsRules configurations
from one instance to another) with password security:

1 Navigate to \\System Administration Responsibility\Profile\System.
2 Query for the LAAPPS: Enable Migration Security profile option.

3 Set the value to Yes at site level. (This can be controlled further at the responsi-
bility and user levels.)
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Bouncing the Servers

When you finish configuring the remote compilation feature, bounce both the form
server and the concurrent manager server.
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Postinstallation Tasks

Once the installation is complete, you must perform additional tasks specific to the
applications you’ve installed.

AppsFlow

To use AppsFlow, run the Synchronize WF LOCAL Tables concurrent program:

1 Log on to the System Administrator responsibility in Oracle Applications.

2 C(lick on View in the Oracle Applications menu bar, then on Requests in the
View menu. The Find Requests form appears.

3 Click the Submit a New Request button. At the prompt, select Single Request
and click OK. The Submit Request form appears.

4 In the Name list of values, select Synchronize WEF LOCAL Tables. Click on the
OK button.

5 A Parameters form appears. Enter the following values (as shown at the top of the
next page), then click on the OK button:

¢ Orig System: ALL
* Parallel Processes: 1
* Logging Mode: LOGGING

¢ Temporary Tablespace: Choose an appropriate temporary tablespace.
6 In the Submit Request form, click on the Submit button.
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AppsAudit

22

O Submit Regquest

— Run this Req

Copy...

Mame Synchronize WF LOCAL tables

Parameters

Orig System |ALL All Orig Systems

Parallel Processes |1

Logging Mode [LOGGING Logging Activated

Temporary Tablespace | D
4 s | »

(o< | [cancel) [ clear ) ( Help )

To use AppsAudit, complete three tasks. First, set the AuditTrail: Activate profile
option to Yes:

1
2
3

Log on to the System Administrator responsibility in Oracle Applications.
In the Navigator, select Profile, then System.

In the Find System Profile Values form, select AuditTrail:Activate in the Profile
list of values. Then click on the Find button.

Ensure that the AuditTrail: Activate option is set to Yes at the Site level:

Application Responsibility Uszer

Profile Site
l |AuditTraiI:Activate |Yes

4]

A e [ »

Second, add the LACSVREPORT style to the printer you will use for AppsAudit:

1
2

In the System Administrator responsibility, select Install, then Printer, then Register.

A Printers form appears. In its Printer list of values, select the printer you wish
to use with AppsAudit. Note the value that appears in the Type field when you
select the printer, and then click on the Printer Types button.

A Printer Types form appears. In its Type field, query for the Type you noted in
step 2. (Press the F11 key; enter the Type value in the Type field; press Ctrl+F11.)
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4 In the Style list of values, select LACSVREPORT. (The software automatically

supplies an associated value under Driver Name.)

O Printers

Printar Type Description
§ noprint HPLJ4SI B
Type [HPLJ4SI
Description |PCL
— Printer Drivers
~ Style Driver Name

[LACSVREPORT |aT_EFT &

a |

a |

— |

l |
: : :
( Style | [ Diriver J

5 Click on File in the menu bar, then on Save in the File menu.

Third, modify the report style:

1 Still in the System Administrator responsibility, select Concurrent, then Program,

then Define.

2 A Concurrent Programs form appears. In its Program field, query for

Logical Apps AppsAudit Report. (Press the F11 key; enter LogicalApps AppsAudit

Report in the Program field; press Ctrl+F11.)

‘© Cancurrent Pror

3 The Style field displays the value Landwide. Change this to L.andscape.

Program |L|Jgit:al Apps AppsAudit Report ¥ Enabled
Short Mame |[LAADREPORT
Application |Ll:lgil:a| Apps Custom
Description |Generates audit report for the given criteria
r— Executable
Name |LAADREPORT Options |
Method |0rac|e Reports Priarity ’_
~ Req ~ Output
Type | r Format |Text
Incrementar | v Sawe (2
MLS Function | v Prirt
Columns ’_
¥ Use In SRS [ Allow Disabled Values Rows ’_
[ Run Alone i Rastart an System Failura Style W
[ Enatle Trace [TMLE Campliant [ Styla Reguirad
Printar
( Copy to... )I ( Session Contral | [ Incorpatibilities | I Parameters

4 C(lick on File in the menu bar, then on Save in the File menu.
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AppsAccess and AppsControl

To use AppsAccess you must import two xml files, and to use AppsControl you
must import three xml files. To do so, you use a migration utility, which the Installer
programs set up automatically as a part of the installation process.

First, ensure that the migration utility is configured correctly:

1 Log on to the Logical Apps responsibility in Oracle Applications. In that respon-
sibility, select AppsRules.

2 Once the AppsRules form is open, click on Logical Apps Ultilities in the menu
bar, then on Migration Setup in the Utilities menu.

3 A Migration Utility form appears. Ensure that the Setup Host Names tab is selected:

yration Utility 700~

Setup Host Nary Setup Instances

~ Host Name Description
= ||newpurt.whq.logicalapps.com |Dev
|cypress.whq.logicalapps.com |QA

-

4 Confirm that the database server host name (the one selected in step 3 of the
database server installation process) is displayed in the Host Name column. The

Installer program should have inserted this value during installation.

5 Click on the Setup Instances tab:

% Logics S - Mg

Setup Host Names

Host Mame Instance Port Murmber  User Marme Pagsword
= I‘newpurl.whq.Iugicalapps.cum |visdev |1525 |apps
‘cypress.whq.logicalapps.com |visdh |1521

24

‘Mm
[apps —

\

\

\

\

-

Connect String hdhc:uracle:thin:@newporl.whq.I0gicalapps.cum:1525:visdev

6 Ensure that appropriate values are displayed in the Host Name, Instance (SID),
Port Number, User Name, and Password columns. (The first three values are
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those specified in step 3 of the database server installation process, and the last
two are those specified in step 4.) Again, the Installer should have inserted these
values automatically.

7 Having confirmed these values (or, if necessary, entered them), close the
Migration Utlity form.

The five xml files are located in subdirectories of the staging directory you selected in
step 2 of the database server installation process. For AppsAccess the files are located
in StagingDirectory/ AppsAcces/db/scripts, and include the following:

e laa_apps_access_rule.xml
e laa_apps_access_flow.xml

For AppsControl the files are located in StagingDirectory/ AppsControl/db/sctipts, and
include the following:

e appscontrol_notification.xml
e appscontrol_approval.xml
e appscontrol_reject.xml

For each application, the files must be imported in the order shown. Complete the
following procedure once for each of the files:

1 With AppsRules open, click on Logical Apps in the menu bar, then on Import
from File in the Utilities menu. An Import from File form appears:

Import from File

Directory |fexportfhomefuracIefrks‘tagefDE_l]?Dech]l]ﬁ_’

File MName |Iaa_apps_access_rule.xml

Diebug Level ||-0W -

( Cancel ) ( Clear ) ( Import J

N

In the directory box, type the path to the folder that contains the import file.
3 In the File Name box, type the name of the file you want to import.

4 Select a value for Debug Level. Ordinarily, select Low; select High instead if you
need to uncover the cause of a failed import.

5 Click on the Import button. A concurrent request message displays the ID num-
ber of the concurrent request under which the import operation is carried out.
Click on the OK button to clear the message.
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AppsAccess Concurrent Program

If you are upgrading AppsAccess from an earlier version, the name of one of its con-
current programs may not have been updated correctly. To correct the program name:

1
2

Log on to the System Administrator responsibility in Oracle Applications.

In the Navigator, select Concurrent, then Program, then Define. The Concurrent
Programs form opens.

Query for the Conflict Data Purge program: Press F11, type the phrase .4
AppsAccess Conflict Data Purge in the Program field, and press Ctrl+F11.

© Concurrent Programs oo,
Program |LA Appshccess Conflict Data Purge v Enabled
Short Name |LA.A_CONFLICT_PURGE
Application |Logical Apps Custom
Description |LA AppsAccess Conflict Data Purge
— Executable
Mame |LM_CONFLICT_PURGE Options |
tethod |PLISQL Stored Procedure Priarity l_
— Regquest — Output
Type | Forrnat |Text <
Incrementaor | W Save (T)
MLS Function | [+ Print
Calumns ,—
W Use In SRS [ Allow Disabled Values Rows |
[ Run Alone W Restart on System Failure Style
[ Enable Trace [TMLE Campliant [" Style Required
Printer
( Copy to... ) ( Session Contral | [ Incompatibilities | I Parameters )

4 In both the Program and Description fields, type the following new value for the

name of the program: 1.4 Apps.Access Archive User Conflict Data. Do not change
any other values.

Save the change: Click on File in the menu bar, and then Save in the File menu.
Then close the Concurrent Programs form (click on the X symbol).

If you are performing a new installation of AppsAccess, this issue does not arise; the
program is named correctly, and you need not take any corrective action.

SQL Rule Compilation

From within AppsRules, you must run a option to compile SQL rules:

26

1

Log on to the Logical Apps responsibility in Oracle Applications. In that respon-
sibility, select AppsRules..

Once the AppsRules form is open, click on Tools in the menu bar, and then
AppsRules Compile All Active SQL Rules in the Tools menu.
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3 A pop-up message informs you of an ID number for the concurrent request that
executes the SQL rule compilation. Make a note of the number, and then click
on the OK button to close the message.

4 Verify that the request is successfully completed.
a Click on View in the menu bar, then on Requests in the View menu.

b A Find Requests form opens. In it, click on the Specific Request radio button.
Type the ID number of your concurrent request in the Request ID field, and
click on the Find button.

¢ A Requests form opens. In the row displaying information about your
request, ensure that the entry in the Phase field is Completed (you may need to
click the Refresh Data button), and the entry in the Status field is Norwzal.

d Click on the X in the upper right corner of the Requests form to close it.

Special Cases

If the database server and concurrent manager server are on different hosts, make
the following changes to the TKprof script (LATKPROF.prog), which is located in the
Logical Apps binary directory on the concurrent manager server. (The changed lines
are shown in boldface.) The value <db_login> is the database server name, and the
value <db_hostname> is the user name to log on to the database server.

#!/bin/sh

oracle login=$31

tempfile=$$latkprof.txt
temptrc=$$latkprof. trc

echo Temp file S$tempfile

echo tkprof directory "$5"

pwd

tkfiles='ssh <db_login>@<db_hostname> 1s $5'"
for 1 in S$tkfiles

do

echo processing $i

scp <db_ login>@<db hostname>:$i /tmp/Stemptrc
tkprof /tmp/Stemptrc /tmp/Stempfile explain=$1
cat /tmp/Stempfile

rm /tmp/Stempfile

rm /tmp/$temptrc

done

If you have multiple APPS schemas, the LA_ENHNCMTMGR_PKG must be created as
a synonym under each of these schemas. To perform this operation, run the
following command:

create synonym LA ENHNCMTMGR PKG for apps.LA ENHNCMTMGR PKG

If this is not set, the following error message appears when a user attempts to log on
to a read-only or MRC (multiple reporting currency) responsibility:

la enhncmtmgr pkg not declared
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Validation

As a part of the installation process, the Installer programs complete several
“behind-the-scenes” tasks. Open Oracle Applications forms to confirm that these
tasks have been completed. (As you perform these validation steps, you may be

instructed to “query for” a value. If so, press the F11 key, type the specified value in
a specified field, and press Ctrl+F11.)

1 Log on to the System Administrator responsibility in Oracle Applications.

2 Seclect Application, then Register.

3 In the Application field, query for Logical Apps Custom. The form should
contain the following values:

Application

Short
Mame

Basepath

Description

||Logical Apps Custom

[XXLAAPPS [XXLAAPPS_TOP [Logical Apps Custom Application
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Switch to the Application Developer responsibility. (Select File in the menu bar,
then Switch Responsibility in the File menu; then select Application Developer
in the Responsibilities form.) In the Application Developer Navigator, double-
click on Application, then Form. In the Form field, query on LABIZ. The form
should contain the following values:

Application Uszer Form Mame

Description

|Lugica| Apps Custom |AppsRuI9s

|Logica| Apps AppsRules =

Switch back to the System Administrator responsibility. In its Navigator, select
Security, then Responsibility, then Request. In the Request Groups form, query
for the Logical Apps Request Group. The form should contain the following

values:
Group |LogicaIApps Request Group
Application |Logical Apps Custom
Code |LOGAPPSRG
Description |Request Group for LogicalApps Applications
—n
~ Type Marme Application
||Appli[:atiun v||L|J§|i[:al Apps Custom |Lugica| Apps Custom =
| | |
| | |
u | |
u | |
(l | |
I | |
| | |
| | |
| I | S
Description  |Logical Apps Custom Application
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6 Still in the System Administrator responsibility, select Application, then Menu in
the Navigator. In the Menus form, query for LAAR_NAVIGATE and confirm the
values shown in the following illustration. (Note that the illustration is a compos-
ite, showing entries that would appear if you were to use the scroll bar in the
Menus form.)

Menu [LAAR_NAVIGATE [ ViewTree.. )
User Menu Name |LugicaIApps AppsRules
Menu Type |Standard
Description |Menu for LogicalApps Applications

~ 3eq Prampt Submenu Function Description Grant

|1l] |.AppsRuIes | |Appsru|es |LogicaIApps AppsRules =t
. |2I] | | |AppsExtend |LugicaIApps AppsExtend M
. |3I] | | |AppsExtend Value Furn|AppsExtend Value form function |+ -
. |4I] | | |ﬁppsFIuw Constraints |AppsFIuw Constraints form functi(?
. |5I] | | |ﬁppshl'|igrate |AppsRuIes Migration form functio v
. |BI] | | |£\ppsRuIes Libraries |AppsRuIes Libraries form functiorv
. |?I] | | |ﬂppsWatch |AppsWatch form function v
. |BI] | | |Appsru|es Audit |AppsRuIes Audit form function ¥
s | [Flexfield Values [FND Flexfields v
. |9I] |Reques‘ls: Run | |LogicaIApps Reports |LogicaIApps SRS v
. |11I] | | |AppsFIow |AppsFIuw form function v
. |12I] |Find Processes | |Find Processes |Find Workflow Processes Functio v
[130 [Find Notificatior| [Find Notifications [Find Workflow Notifications Funci¥
s | | [Appsaudit |appsAudit form function v
6o | | |Appshudit Online |AppsAudit Online form function ¥
. |1?I] | | |ﬁ\ppsAudit Report |AppsAudit Report form function ¥
. |2I]5 |AppsAccess 5 De| |ﬁ\ppsAccess Define Con'|AppsAccess - Define Conflict Rulev
. |21I] |AppsAcce&s 5 Us| |ﬁ\ppsAccess User Conflin|AppsAcces - User Conflict Approyv’
. |215 | | |AppsAccess Global Suh|AppsAcce&s - Global Subscribers
. |22I] | | |AppsAccess Activate Re|AppsAcce&s - Activate Responsibilv
. |225 | | |AppsAccess Function W|AppsAcces - Function Where Usev
. |41l] |AppsCuntroI | |AppsControI Wizard |Logica| Apps AppsControl Wizard v
. |42I] | | |AppsCuntruI Change Re|LugicaI Apps AppsControl Reasorv
. |911 | | |I'l|'|ass Associate Func‘tiul|hl'|ass Associate Function v
. |999 |Insta|| History | |Lugica| Apps Installatiu|LugicaI Apps Products Installatior .

If you are upgrading from an earlier version, the menu may contain an obsolete
item and may lack two new items. Check that entries appear at sequence numbers
205 and 210, and contain the following values. If not, create the entries manually.

e Sequence 205: Prompt is “AppsAccess - Define Conflict Rules”; Submenu is
blank; Function is “AppsAccess Define Conflict Rules”; Description is
“AppsAccess - Define Conflict Rules”; Grant box is checked.

*  Sequence 210: Prompt is “AppsAccess - User Conflict Approval”’; Submenu

is blank; Function is “AppsAccess User Conflict Approval”; Description is

“AppsAccess - User Conflict Approval”’; Grant box is checked.

Also, delete an entry with the value “AppsAccess” in the Prompt and Function
columns, if one exists.

Installation Guide: AppsRules Suite 7.0

31



Chapter 4: Validation

7 In the System Administrator Navigator, select Security, then Responsibility, then
Define. In the Responsibilities form, query for LogicalApps. (This is the respon-
sibility you would assign to Oracle Applications users so that they can use
Logical Apps applications.)

O Res ihilitie
Responsibility Name |Logica| Apps Effective Dates ———————————————
Application |Logica| Apps Custom Fram ’m
Responsibility Key |LMPPSRULES Ta
Description |LogicaIApps Applicati Rest ihil
A le From Data Group
® Qracle Applications Mame |Standard

T Oracle Self Service Weh Applications

Applicati Logical Apps Custom
' Oracle Mobile Applications pRication | 2 PP

G
henu ‘Lngicalﬁpps AppsRules roup

Web Host Name ‘
Web Agent Marme ‘

Mame |LogicaIApps Request Group

Application |Ll:lgica| Apps Custom

Menu Exclusions Excluded ltems Securing Attributes
~ Type Mame Desctiption
||Funt:1inn v“ | N
u I |
u I |
[ | 3

Switch to the Logical Apps responsibility and, in the Logical Apps Navigator, select
AppsRules. Then do the following:

1 Select Tools in the menu bar, then on AppsRules Configurations in the Tools
menu.

2 An AppsRules Configurations form appears. Confirm that a value displayed in
the UTL Path field:

nfigurations

UTL Path (TR

Library “ersion |5_|]_|]_|]

Farm “ersion |ﬁ_5_|].|].l]

Package Yersion |ﬁ.1.l].l]

Refresh Cache
Done

3 The UTL Path field value should match the name of one of the directories set
for UTL PATH in your environment. To confirm that it does, run the following
SQL query to generate a list of those directories:

select value from gvSparameter where name='utl file dir'
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Finally, confirm that appropriate values have been set for AppsRules libraries:

1 With AppsRules open, click on LogicalApps Ultilities in the menu bar, then on
AppsRules Libraries in the Logical Apps Ultilities menu.

2 With a Logical Apps Libraries form open, click on Tools in the menu bar, then
on Value Sets in the Tools menu.

3 In the Name field of the Find Value Set form, enter the value 1.4% and click on
the Find button.

Find Values By

W alue Set

O Key Flexfield

O Descriptive Flexfield

O Concurrent Program

Inde

E GORY Independent
LAAC_COMTROL_STATUS Independent

LAAR_LIBRARY_ASSIGNED_TO Independent
LAAR_LIBRARY _CATEGORY Independent -
LAAR_LIBRARY_MODULES Independant
LAAR_LIBRARY_THEME Independent
LAAR_LONG_DESCRIPTION Independent -
A e [ v

4 Sclect (one at a time) the LAAC_CATEGORY, LAAR_LIBRARY_MODULES, and
LAAR_LIBRARY_THEME entries. For each, confirm that a Segment Values form

displays the value ALL in the Values field of the Values, Effective tab. For
example:

“alue Set—— Key Flexfield————— Descriptive Flexfield———— Concurrent Program

RETGEN AAR LIBRARY MODULH |Lihrary Modules

Dependent Value Set | |

Independent Value | |

— Values (LAAR_LIBRARY_MODULES) v —
Yalues, Hierarchy, Gualifiers
Translated Enabled

~ Walue Walue Description | From Tao [1]
| [atL [Module ta include all rules| ¥ | | [~
u | | =) | [
Il | | | | .
a | | =} | [
(l | | o | [
(l | | o | [

| | | O | L=

( Define Child Ranges [ Iove Child Ranges I Siew Higrarchigs )
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Installation History

You can review information about the installation of files for your AppsRules imple-
mentation. To do so:

1 Log on to the Logical Apps responsibility.

2 In the Navigator, select Install History. The Installation History form appears:

_Install Datetime Release Component Host Mame  Install Status Product User Name Schema Staging Dir

[ Jo7 _DEC 2005 10:06:01JFK0 [FrRM [wail [Success [appsCore  [oracle [xXLAAPPS |[home/oracle/dtstage/FRM ~
' [07_DEC 2005 10:06:01 [7.0 [FRM |vail |SUCCESS |AppsForm  |oracle [XXLAAPPS |homeoracle/dtstage/FRM,

' [07_DEC 2005 10:06:01 [7.0 [FRM |vail [SUCCESS |AppsAudit |oracle [XXLAAPPS |homeoracle/dtstage/FRM| -
' [07_DEC 2005 10:06:01 [7.0 [FRM |vail [SUCCESS |AppsControl |oracle [XXLAAPPS fhome/oracle/dtstage/FRM,
' [07_DEC 2005 10:06:01 [7.0 [FRM |vail |SUCCESS |AppsAccess |oracle [XXLAAPPS |/homeforacle/dtstage/FRM
' [07_DEC 2005 10:06:01 [7.0 [FRM |vail |SUCCESS |AppsFlow |oracle [XXLAAPPS |homeoracle/dtstage/FRM,

' [07_DEC 2005 10:06:01 [7.0 B |vail |SUCCESS |AppsCore  |oracle [XXLAAPPS |home/oracle/distage/DB_(

' [07_DEC 2005 10:06:01 [7.0 B |vail |SUCCESS |AppsForm  |oracle [XXLAAPPS |home/oracle/distage/DB_(

' [07_DEC 2005 10:06:01 [7.0 B |vail [SUCCESS |AppsAudit |oracle [XXLAAPPS |home/oracle/distage/DB_(

' [07_DEC 2005 10:06:01 [7.0 B |vail [success [AppsFlow [oracle [XXLAAPPS |home/oracle/dtstage/DB_0

Each row provides information about the installation of a Logical Apps program
element — for example, the top row in this illustration shows that the AppsCore
element for version 7.0 of the forms server was successfully installed. Because
there are several elements for each of the forms and database servers, a single
installation of AppsRules fills multiple rows in the grid — for example, all of the
rows in this illustration pertain to an installation performed on the seventh of July.

3 To view a list of the files installed for a given element, click on the row for that
element and then on the Installed Files button. The following form appears:

Praduct Filename Revision Install Status
| [cusTOM.plI [1.0 [Success g
' [appsCore [LAADDFUNC.fmb [1.0 |Success
' [appsCore [LAAEELM.fmb [1.0 |Success
' [appsCore [LAAFACCOBJ.fmb [1.0 |Success
' [appsCore [LAAFCONST.fmb [1.0 |Success
' [appsCore [LAAFLOW.fmb [1.0 |Success B
. |AppsCore |LA.APEN.fmh |1.I] |Success
' [appsCore [LAAPPSAUDIT.fmb [1.0 |Success
' [appsCore [LAAPPSAUDITREPORT.fmh [1.0 |Success
' [appsCore [LAAUDIT.fimb [1.0 Success S

Click on the Close button to clear this form.
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4 Finally, to review information about all currently installed files (regardless of
whether they were added in the most recent installation), click on the Current
File Versions tab:

Install History Current File®

File Mame Revision Install Time Product Release Component  Install Status
'|[cusTom.pn [1.0 07 _DEC 2005 10:06:01 |AppsCore  [7.0 [FRM |Success -l
||customException.java [1.0 |07-DEC2005 09:59:57 |AppsCore  [7.0 [pB |Success u
|[EntityName.java [1.0 |07-DEC2005 09:59:57 |AppsCore  [7.0 [pB |Success
|[1outiLjava [1.0 |07-DEC2005 09:59:57 |AppsCore  [7.0 [pB |Success

|[Insert java [1.0 |07-DEC2005 09:59:57 |AppsCore  [7.0 [pB |Success
'|[LaAACCESS.fmb [13 |07 _DEC 2005 10:06:01 |AppsAccess [7.0 [FRM |Success
'||Laaconacc.raf [1.0 |07-DEC2005 09:59:57 |AppsAccess [7.0 [pB |Success
'|[Laaconacc T.rif [1.0 |07-DEC2005 09:59:57 |AppsAccess [7.0 [pB |Success
'|[LaacoNACR rdf [10 |07-DEC 2005 09:59:57 [Appshccess 7.0 B Success
|[LAACONACR_T.rdf [1.0 |07-DEC 2005 09:59:57 [Appsiccess 7.0 [bB |Success
'|[LAACONRS. rdf [1.0 |07-DEC 2005 09:59:57 [Appsiccess 7.0 [bB |Success
[|LAACONRS T.rf [1.0 [07DEC 2005 09:59:57 [AppsAccess [7.0 [bB [Success -

5 To close the Installation History form, click on its X symbol.
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